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 利用 MPLAB® Harmony v3 TCP/IP 协议栈实现文件传输协议

简介

文件传输协议（File Transfer Protocol，FTP）是一种应用层协议，用于在本地主机和远程主机之间传输文件。它基于

TCP（例如 HTTP）运行。

本文档重点介绍最新 MPLAB Harmony v3 框架中提供的 MPLAB Harmony v3 TCP/IP 协议栈的 FTP 实现，并提供了

使用 SAM E70 的 FTP 客户端演示。该演示使用 FTP 实现以太网自举程序，SAM E70 客户端通过该自举程序从 FTP
服务器下载二进制文件以进行自编程。

缩写

本文档使用下列缩写：

• FTP——文件传输协议（File Transfer Protocol）
• HTTP——超文本传输协议（Hypertext Transfer Protocol）
• TCP/IP——传输控制协议/Internet 协议（Transmission Control Protocol/Internet Protocol）
• DHCP——动态主机配置协议（Dynamic Host Configuration Protocol）
• DFP——器件系列包（Device Family Pack）
• MHC——MPLAB Harmony 配置器（MPLAB Harmony Configurator）
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1. FTP 概述
FTP 基于客户端/服务器模型架构构建，在客户端和服务器之间使用单独的控制和数据连接。

图 1-1. FTP 模型
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1.1 客户端
文件传输协议客户端（FTP 客户端）是一种在主机计算机和远程 FTP 服务器之间建立连接的软件。使用 FTP 客户端，

可以通过 TCP 在两台计算机之间双向传输数据和文件。FTP 客户端基于客户端/服务器架构工作，其中主机计算机为客

户端，远程 FTP 服务器为中央服务器。当主机计算机通过指定 FTP 服务器的域、IP 地址、用户名和密码（在某些情

况下，还需要指定端口号）连接到该服务器时，FTP 客户端即开始工作。完成用户身份验证后，两个系统之间将建立

连接，主机计算机可以将数据上传到 FTP 服务器上。FTP 客户端通常支持单文件传输或多文件同时传输。此外，大多

数 FTP 客户端可以同时连接到多个 FTP 服务器，从而提供上传过程的状态更新以及有关传输成功和失败的通知。主机

计算机也可以使用 FTP 客户端从 FTP 服务器下载文件。

1.2 服务器
FTP 服务器支持下载和上传文件。下载 FTP 服务器上的各种文件和文件夹时可能存在访问限制，具体由 FTP 服务器管

理员确定。FTP 服务器上的文件可以通过常用的 Web 浏览器获取，但这些浏览器可能不支持协议扩展，例如 FTPS
（FTP 安全）。所有文件传输协议站点地址均以“ftp://”开头。

1.3 连接
为了传输文件，FTP 需并行使用以下 TCP 连接：控制连接和数据连接。

控制连接：FTP 使用控制连接来发送控制信息，例如用户标识、密码、用于更改远程目录的命令以及用于获取和存储

文件的命令。控制连接的默认端口号为 21。所有控制连接均在该端口上发起。

数据连接：为了发送文件，FTP 需使用数据连接。数据连接的默认端口号为 20。但是，数据连接并不总是在该端口上

发起。在不同的工作模式下，也可能在其他编号的端口上发起。有关更多信息，请参见 1.4  工作模式。

会话：

当客户端与服务器之间启动 FTP 会话时，客户端将发起与服务器端的控制 TCP 连接。客户端将通过该连接发送控制信

息。当服务器收到控制信息时，它将发起与客户端的数据连接。一条数据连接只能发送一个文件。但控制连接在整个

用户会话中始终保持活动状态。

 AN3475
FTP 概述

© 2021 Microchip Technology Inc.  应用笔记 DS00003475A_CN-第 3 页



1.4 工作模式
FTP 支持以下两种工作模式，而工作模式决定着建立数据连接的方式。在这两种工作模式下，均通过端口 21 与 FTP
服务器建立控制连接。

主动模式：在主动模式下，服务器发起数据通道连接。连接序列如下：

• 客户端从一个随机端口连接到 FTP 服务器上的端口 21。这是控制/命令通道。

• 客户端使用控制连接来通知（通过 PORT 命令）执行监听的端口号。该端口将用于数据通道。

• 服务器将端口 20 连接到为数据通道指定的客户端端口。

主动模式对于服务器而言安全性较高，因为它不需要在服务器端打开不安全的端口。服务器负责启动与客户端的数据

连接。但必须注意的是，主动模式对于客户端而言安全性较低。

在客户端受防火墙保护的情况下，主动模式可能会失败，因为如果未在防火墙中解除阻止服务器的随机端口，则防火

墙可能会阻止传入的服务器连接（用于数据通道）。

被动模式：在被动模式下，客户端发起数据通道连接。

• 客户端从一个随机端口连接到 FTP 服务器上的端口 21。这是控制/命令通道。

• 客户端发起 PASV 命令

• 服务器发送用作数据通道的随机端口号作为答复

• 客户端从一个随机端口连接到服务器指定的端口号

建议对受防火墙保护的客户端使用被动模式，因为没有针对客户端的入站连接请求。

按数据表示形式划分的模式

FTP 允许以下列几种格式传输文件：

• ASCII 模式：该模式用于纯文本文件或基于 ASCI 的文件，例如 HTML 文件、文本文件或 PostScript。ASCII 是默

认的传输类型。

• 二进制模式：该模式也称为图像模式，用于传输非 ASCII 文件，例如图像、应用程序以及生成的归档/文件柜文件

（如.zip 和.tar 文件）。在该模式下，文件无需任何转换即可传输。这样一来，在两台计算机之间传输后依旧可保

持相同的文件结构。这对于图片、音乐和视频之类的文件非常重要，因为这类文件必须精确复制才能保持数据的

完整性。

• EBCDIC 模式：该模式用于在主机之间传输使用 EBCDIC 字符集的纯文本。

1.5 FTP 应用
FTP 应用广泛，涵盖从日常业务操作到嵌入式系统数据传输的方方面面。以下给出了一些用例：

• 组织使用 FTP 来支持不同办公地点和分支机构的员工之间共享文件。

• 员工使用 FTP 与同事和外部业务合作伙伴共享文件。

• IT 团队使用 FTP 将数据传输回灾难恢复（Disaster Recovery，DR）站点。

• 网站管理员团队使用 FTP 将网页、Web 应用程序文件和图像传输到他们的 Web 服务器。

• 远程嵌入式系统使用 FTP 下载应用程序二进制文件以进行固件更新。

• 获取存储在远程操作 MCU 和 MPU 中的日志文件。
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2. MPLAB Harmony v3 中的 FTP
MPLAB Harmony v3 的 TCP/IP 协议栈库为 FTP 模块的 API 提供了操作便捷的“C”语言界面。该库支持 FTP 服务器

和客户端，有助于将文件上传和下载到嵌入式客户端和服务器。

2.1 FTP 服务器模块
FTP TCP/IP 协议栈库的接口在 ftp.h头文件中定义。要在项目中使用 FTP 服务器，需要使用 TCP/IP 协议栈和 FAT
FS 之类的文件系统。

可以使用 MHC 在 MPLAB Harmony v3 TCP/IP 项目中使能 FTP 服务器：Project Graph > Application Layer > TCP/IP
Application Layer Configurator > FTP Server（项目图 > 应用层 > TCP/IP 应用层配置器 > FTP 服务器）。

图 2-1. 项目图

表 2-1. FTP 服务器模块文件

文件 说明

ftp_config.h FTP 服务器的配置（根据 configuration.h 中生成的符号）

ftp.h FTP 服务器 TCP/IP 协议栈库的接口

ftp.c FTP 服务器的实现

有关 FTP 服务器模块的更多信息，请访问 https://github.com/Microchip-MPLAB-Harmony/net/blob/master/doc/
help_harmony_tcpip.pdf。

2.2 FTP 客户端模块
FTP 客户端模块可在不同设备之间可靠、高效地传输数据，而无需担心不同主机的文件存储系统存在差异。

表 2-2. FTP 客户端模块文件

文件 说明

ftpc_config.h FTP 客户端的配置（根据 configuration.h 中生成的符号）

ftpc.h FTP 客户端 TCP/IP 协议栈库的接口

ftpc.c FTP 客户端协议的实现

下表列出了 FTPC 模块支持的一些 FTP 命令。

表 2-3. FTPC 模块支持的 FTP 命令

FTP 命令 协议栈命令类型 函数名称

USER——发送用户名 TCPIP_FTPC_CMD_USER TCPIP_FTPC_Login
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...........（续）

FTP 命令 协议栈命令类型 函数名称

PASS——发送密码 TCPIP_FTPC_CMD_PASS TCPIP_FTPC_Login

ACCT——发送帐户信息 TCPIP_FTPC_CMD_ACCT TCPIP_FTPC_Login

TYPE——设置传输类型 TCPIP_FTPC_CMD_TYPE TCPIP_FTPC_SetType

STRU——设置文件传输结构 TCPIP_FTPC_CMD_STRU TCPIP_FTPC_SetStruct

MODE——设置传输模式 TCPIP_FTPC_CMD_MODE TCPIP_FTPC_SetMode

PASV——进入被动模式 TCPIP_FTPC_CMD_PASV TCPIP_FTPC_SetActiveMode
TCPIP_FTPC_SetPassiveMode

PORT——打开数据端口 TCPIP_FTPC_CMD_PORT TCPIP_FTPC_Connect

RETR——获取远程文件 TCPIP_FTPC_CMD_GET TCPIP_FTPC_GetFile

STOR——将文件存储到远程主机上 TCPIP_FTPC_CMD_PUT TCPIP_FTPC_PutFile

NLST——远程目录的名称列表 TCPIP_FTPC_CMD_NLST TCPIP_FTPC_NameList

LIST——列出远程文件 TCPIP_FTPC_CMD_LIST TCPIP_FTPC_List

DELE——删除远程文件 TCPIP_FTPC_CMD_DELE TCPIP_FTPC_DeleteFile

CWD——更改工作目录 TCPIP_FTPC_CMD_CWD TCPIP_FTPC_Change_Dir

CDUP——CWD 指向当前目录的父目录 TCPIP_FTPC_CMD_CDUP TCPIP_FTPC_ChangeToParentDir

MKD——创建远程目录 TCPIP_FTPC_CMD_MKD TCPIP_FTPC_MakeDir

RMD——删除远程目录 TCPIP_FTPC_CMD_RMD TCPIP_FTPC_RemoveDir

PWD——打印工作目录 TCPIP_FTPC_CMD_PWD TCPIP_FTPC_Get_WorkingDir

QUIT——终止连接 N/A TCPIP_FTPC_Logout

除了实现 FTP 命令外，客户端模块还通过 USART 终端提供用户界面。这样，用户便可通过进入终端来提供所需的

FTP 命令。

所有 FTP 客户端命令均以关键字“ftpc”开头，例如 ftpc login <username> <pswd>。
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3. FTP 客户端：自举程序应用程序
以下各节介绍了本应用程序所需的软件和硬件并对应用程序进行了概述。

3.1 先决条件
硬件：

• SAM E70 Xplained Ultra 评估工具包——1 个

• SD 卡——1 个

• 以太网电缆（RJ45）——1 条

• USB 线缆——1 条

软件：

• MPLAB X IDE（v5.30）
• MPLAB XC32/32++编译器（v2.40）
• MPLAB Harmony 配置器（v3.4.0）

– Harmony bsp 资源库 v3.5.0
– Harmony csp 资源库 v3.5.2
– Harmony core 资源库 v3.5.2
– Harmony dev_packs 资源库 v3.5.0
– Harmony net 资源库 v3.5.1

3.2 应用程序概述
本示例演示如何创建一个应用程序，让 FTP 客户端从 FTP 服务器下载二进制文件，然后使用该文件刷写单片机。本应

用程序中使用以 SDCARD 作为存储介质的 FAT-FS 文件系统，FTP 客户端将对该 FS 进行读/写操作。
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图 3-1. 流程图

3.2.1 应用程序代码

FTP 客户端的用户应用程序必须发起 FTP 连接请求。根据服务器对请求的响应，客户端必须提供用户名和密码才能登

录。FTP 客户端成功登录后，即可在服务器和客户端之间传输数据。在该应用程序中，客户端从服务器下载二进制文

件，该文件将存储到 SD 卡上，随后刷写到单片机中。

以下代码显示了 FTP 连接和登录的应用程序代码。

case APP_Connect_FTP:
TCPIP_FTPC_Get_Status (ftpcHandle, &ftpcStatus);
if (ftpcStatus.isConnected)
{

SYS_CONSOLE_MESSAGE ("FTP Client connected \r\n");
appData.state = APP_Logign_FTP;
SYS_CONSOLE_MESSAGE ("Login with your credentials \r\nEg: ftpc login
username psswd\r\n");

}
break;

case APP_Login_FTP:
TCPIP_FTPC_Get_Status (ftpcHandle, &ftpcStatus);
if (ftpcStatus.isLoggedIn)
{

SYS_CONSOLE_MESSAGE ("FTP Client logged in \r\n");
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appData.state = APP_SET_CURRENT_DRIVE;
}
break;

3.2.2 创建应用程序

本应用程序在 MPLAB Harmony 配置器中创建，因为该配置器可提供易于使用的 GUI，能够简化器件设置、库选择、

配置和应用程序开发。

有关 MHC 的更多信息，请参见 https://github.com/Microchip-MPLAB-Harmony/mhc/wiki。

MPLAB Harmony 配置

• 要使用 MPLAB X IDE 为 SAME70Q21B 创建 32 位 MPLAB Harmony v3 项目，请访问 https://
microchipdeveloper.com/harmony3:same70-getting-started-training-module。

• 启动配置时，默认将显示器件系列包（Device Family Pack，DFP）、系统、CMSIS 包和 EFC。

• 对于本演示，必须添加终端通信、系统服务、文件系统和 TCP/IP 功能。

• 有关已配置这些组件的 Harmony 配置文件（.xml）的信息，请参见本应用笔记的源代码

（ftp_bootloader\firmware\src\config\default\sam_e70_xult.xml）。

从 MPLAB Harmony 配置器载入该文件：MPLAB Harmony Configurator > File > Load State（MPLAB Harmony
配置器 > 文件 > 载入状态）。

• 下图给出了完整的项目图：

图 3-2. 完整的项目图

• 由于本文档的重点是 FTP，因此下文主要介绍与 TCP/IP 相关的配置：

TCP/IP Harmony 配置

– 对于 TCP/IP 基本配置器，请按照下列步骤操作：

1. 添加 TCP/IP Basic Configurator（TCP/IP 基本配置器）将创建一个 BASIC CONFIGURATION（基本

配置）视图。可以选择不同的视图，如下图所示。
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图 3-3. 选择视图

2. 在基本配置器视图中，使能 TCPIP CMD、TCPIP CORE 和 NETCONFIG 组件。

图 3-4. 基本配置器视图

3. 在 TCP/IP CORE 配置选项中，可以根据应用要求调整 TCP/IP Stack Dynamic RAM Size（TCP/IP 协

议栈动态 RAM 大小）。本示例中分配的 RAM 为 67,960 字节（66 KB）。

图 3-5. 配置选项

4. 在 NETCONFIG 选项中，配置必要的网络详细信息，例如 IP 地址和网关地址：
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图 3-6. NETCONFIG 选项

– TCP/IP 应用层配置器

1. 在 APPLICATION LAYER（应用层）视图中，使用 TCP/IP Application Layer Configurator 使能

ANNOUNCE（通告）、FTP CLIENT（FTP 客户端）和 DHCP CLIENT（DHCP 客户端）组件。

ANNOUNCE 模块有助于在支持 DHCP 的网络上发现设备，而 DHCP CLIENT 模块允许应用程序从网

络上的 DHCP 服务器动态获取 IP 地址。

图 3-7. APPLICATION LAYER 视图

2. 在 FTP CLIENT 配置中，Enable FTP Client Commands（使能 FTP 客户端命令）选项允许用户通过

串行终端与 FTP 客户端进行交互。可以根据需要增大发送和接收缓冲区的大小（即 1,024）。

图 3-8. FTP CLIENT 配置
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3.3 运行应用程序

3.3.1 硬件设置

按照以下步骤设置硬件：

1. 确保 ERASE 跳线断开。

2. 断开 J805 跳线。

3. 将 LAN8740 PHY 子板插入 ETHERNET PHY MODULE 插座。

4. 将 micro-USB 线缆从计算机连接到 SAM E70 Xplained Ultra 评估工具包上的 DEBUG USB 连接器。

5. 通过 RJ45 连接器在路由器/交换机与 SAM E70 XPlaed Ultra 评估工具包之间建立连接。网络上的 DHCP 服务

器将为该工具包分配 IP 地址。该工具包还可以连接到 PC 上的 RJ45 端口，因此 DHCP 服务器可能不可用，此

时该工具包将使用预先配置的静态 IP 地址。

6. 将 SD 卡插入硬件板背面的 SD 卡插槽。

3.3.2 对 MCU 进行编程

按照以下步骤对 MCU 进行编程：

1. 在 MPLAB X IDE 中打开项目：（File > Open Project（文件 > 打开项目），然后浏览到

ftp_bootloader\firmware\sam_e70_xult.X）。

2. 通过单击 （Make and Program device（编译并编程器件）图标）编译项目并将其编程到目标板。

3.3.3 设置 FTP 服务器

在运行 FTP 客户端应用程序之前，用户需要按照以下步骤设置 FTP 服务器。

对于本演示，使用 FileZilla 服务器界面作为在用户 PC 上运行的 FTP 服务器。有关更多信息，请访问 https://
wiki.filezilla-project.org/Documentation。

按照以下步骤设置 FileZilla 服务器：

1. 打开 FileZilla 服务器界面。

2. 在弹出窗口中的管理界面输入主机名、端口和密码。

3. 单击 Connect（连接）。

4. 单击 （用户图标）或转到 Edit > User（编辑 > 用户），以添加客户端。

5. 在用户窗口中，单击 General（通用）。通过单击 Add（添加）添加客户端，然后使能帐户和密码。该用户名

和密码将用于从 FTP 客户端发起连接。
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图 3-9. 用户窗口

6. 在 Shared folders（共享文件夹）部分，添加要下载的二进制文件所在的文件夹的路径。

图 3-10. 添加路径

3.3.4 连接 FTP 客户端

按照以下步骤连接 FTP 客户端：

1. 通过终端窗口应用程序（lTera Term）连接到 SAM E70 Xplained Ultra 板枚举的 COM 端口。

2. 重启应用程序（即复位 SAM E70 板）。

3. IP 地址准备就绪后将显示在终端上，用户可以通过键入以下内容连接到 FTP 服务器：ftpc connect <host
ip address>。

4. 成功连接后，输入以下登录详细信息：ftpc login <username> <password>。
5. 登录后，使用以下 ftpc 获取从服务器下载二进制文件的命令：ftpc get -a -a <test.bin>。

注： 有关生成二进制文件的步骤，请参见附录部分。

6. 成功下载二进制文件后，可以使用引导命令将其刷写到 MCU。

注： 本项目的最大二进制文件大小配置为 7 KB。对于大于该值的二进制文件，应在 ftp_bootloader 项目的

app.c 文件中增大 APP_DATA_LEN 宏。如果二进制文件大于可用的 RAM，则文件可以分块读取（而不是将完

整文件读取到缓冲区）并进行编程。
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7. 完成编程后，MCU 会自动复位，并且应用程序代码开始执行。将显示以下消息：**** Executing Application
code ****（**** 正在执行应用程序代码 ****）。

图 3-11. 输出：

MCU 复位后，将显示以下消息，表明 MCU 已使用新的应用程序二进制文件重新编程。
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图 3-12. 
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4. 疑难解答
本章介绍了重要的错误消息以及相应的解决方法。

• “FTP timed out”（FTP 超时）——服务器响应时间可能受站点之间距离的影响。如果在连接服务器时出现该消

息，请增大 Connect Timeout（连接超时）设置，以使服务器在登录过程中有更多时间作出响应。

• “Cannot open data connection”（无法打开数据连接）——如果在支持防火墙的 Windows 系统中发生该错误，

则可能是由于防火墙阻止了相应 FTP 数据端口上的连接。可尝试暂时禁用防火墙，然后查看 FTP 连接是否成

功。如果在禁用防火墙的情况下连接成功，则用户可以将防火墙配置为允许所需的端口并予以启用。

• “Client unable to connect using PASV (passive) mode”（客户端无法使用 PASV（被动）模式进行连接）——

确保服务器配置为接受被动连接。例如，在 FileZilla 服务器中，可以通过禁止主动模式来使能被动模式：FileZilla
Server > Server > Active（FileZilla 服务器 > 服务器 > 主动）。
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5. 附录

5.1 生成应用程序二进制文件
通常，对于在闪存中提供自举程序的实现，自举程序位于闪存的基址（起始地址）。应用程序载入闪存中超出自举程

序范围的存储区域。

Flash

Bootloader

Application

0x0000
要在 MPLAB X IDE 中生成应用程序项目的二进制文件，应执行以下操作：

1. 修改应用程序的起始地址。

2. 执行编译后命令，生成 bin 文件。

5.1.1 修改应用程序的起始地址

必须修改应用程序的起始地址，以从所需存储单元（超出自举程序占用的存储区域）开始生成 bin 文件。

要更改应用程序的起始地址，应转到 Project Properties > xc32-ld > Option categories: Symbols & Macros（项目属性
> xc32-ld > 选项类别：符号和宏）。

用户需要定义以下宏：

• ROM_ORIGIN=0x430000
• ROM_LENGTH=0x1d0000
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图 5-1. 项目属性

可以为 ROM 起点分配超出自举程序大小的任何地址值。ROM 长度可以是从 ROM 起点到存储器末尾的存储空间大

小。

5.1.2 生成二进制文件

要生成二进制文件，应按照下列步骤操作：

1. 转到 Project Properties > Building（项目属性 > 编译）。

2. 使能“Execute this line after build”（在编译之后执行该行）编译选项，然后插入以下命令：

${MP_CC_DIR}\xc32-objcopy -I ihex -O binary
"${DISTDIR}/${PROJECTNAME}.${IMAGE_TYPE}.hex"
"${DISTDIR}/${PROJECTNAME}.${IMAGE_TYPE}.bin"

 AN3475
附录

© 2021 Microchip Technology Inc.  应用笔记 DS00003475A_CN-第 18 页



图 5-2. 生成二进制文件

编译项目。bin 文件的输出位于以下路径：<your_project>.X\dist\<config_name>\production\

5.2 所下载二进制文件的自编程
用户可以使用本文档中演示的 FTP 客户端应用程序从任何 FTP 服务器下载所需的应用程序二进制文件。二进制文件下

载到客户端文件系统后，即可编程到 MCU 的闪存中，如下面的流程图所示。
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图 5-3. 编程二进制文件流程图

有关擦除和编程闪存扇区的实现，请参见本应用程序的源代码中的 APP_Flash_Task()函数。

进入应用程序代码

每次复位后，自举程序代码都会检查以下内容：

• 用户按钮（SW0）是否按下

• 分配给应用程序的闪存地址中的应用程序代码是否有效

如果满足以上任一条件，则执行将跳转到用户应用程序代码，而不执行 FTP 客户端自举程序。
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6. 参考资料
• Microchip TCP/IP 协议栈：

https://ww1.microchip.com/downloads/en/appnotes/00833c.pdf
• MPLAB® Harmony v3 TCP/IP 帮助：

https://microchip-mplab-harmony.github.io/net/frames.html?frmname=topic&frmfile=index.html
• MPLAB Harmony v3 的安装和使用：

https://github.com/Microchip-MPLAB-Harmony/mhc/wiki
• RFC 959：

https://tools.ietf.org/html/rfc959
• Microchip 开发人员帮助：

https://microchipdeveloper.com/harmony3:start
• MPLAB Harmony v3：

https://www.microchip.com/mplab/mplab-harmony
• MPLAB Harmony GitHub wiki：

https://github.com/Microchip-MPLAB-Harmony/Microchip-MPLAB-Harmony.github.io/wiki
• 如何设置 MPLAB Harmony v3 软件开发框架：

http://ww1.microchip.com/downloads/en/DeviceDoc/
How_to%20_Setup_MPLAB_%20Harmonyv3_%20Software_%20Development_Framework_DS90003232A.pdf

• 如何创建第一个 TCP/IP 应用程序： https://github.com/Microchip-MPLAB-Harmony/net/wiki/Create-your-first-
tcpip-pplication

• MPLAB Harmony v2 到 MPLAB Harmony v3 TCP/IP 应用程序移植指南： https://github.com/Microchip-MPLAB-
Harmony/net/wiki/H2-to-H3-Migration
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Microchip 网站

Microchip 网站（www.microchip.com/）为客户提供在线支持。客户可通过该网站方便地获取文件和信息。我们的网站

提供以下内容：

• 产品支持——数据手册和勘误表、应用笔记和示例程序、设计资源、用户指南以及硬件支持文档、最新的软件版
本以及归档软件

• 一般技术支持——常见问题解答（FAQ）、技术支持请求、在线讨论组以及 Microchip 设计伙伴计划成员名单

• Microchip 业务——产品选型和订购指南、最新 Microchip 新闻稿、研讨会和活动安排表、Microchip 销售办事

处、代理商以及工厂代表列表

产品变更通知服务

Microchip 的产品变更通知服务有助于客户了解 Microchip 产品的最新信息。注册客户可在他们感兴趣的某个产品系列

或开发工具发生变更、更新、发布新版本或勘误表时，收到电子邮件通知。

欲注册，请访问 www.microchip.com/pcn，然后按照注册说明进行操作。

客户支持

Microchip 产品的用户可通过以下渠道获得帮助：

• 代理商或代表

• 当地销售办事处

• 应用工程师（ESE）
• 技术支持

客户应联系其代理商、代表或 ESE 寻求支持。当地销售办事处也可为客户提供帮助。本文档后附有销售办事处的联系

方式。

也可通过 www.microchip.com/support 获得网上技术支持。

Microchip 器件代码保护功能

请注意以下有关 Microchip 器件代码保护功能的要点：

• Microchip 的产品均达到 Microchip 数据手册中所述的技术规范。

• Microchip 确信：在正常使用的情况下，Microchip 系列产品非常安全。

• 目前，仍存在着用恶意、甚至是非法的方法来试图破坏代码保护功能的行为。我们确信，所有这些行为都不是以

Microchip 数据手册中规定的操作规范来使用 Microchip 产品的。这种试图破坏代码保护功能的行为极可能侵犯

Microchip 的知识产权。

• Microchip 愿与那些注重代码完整性的客户合作。

• Microchip 或任何其他半导体厂商均无法保证其代码的安全性。代码保护并不意味着我们保证产品是“牢不可破”

的。代码保护功能处于持续发展中。Microchip 承诺将不断改进产品的代码保护功能。任何试图破坏 Microchip 代

码保护功能的行为均可视为违反了《数字器件千年版权法案（Digital Millennium Copyright Act）》。如果这种行

为导致他人在未经授权的情况下，能访问您的软件或其他受版权保护的成果，您有权依据该法案提起诉讼，从而

制止这种行为。

法律声明

提供本文档的中文版本仅为了便于理解。请勿忽视文档中包含的英文部分，因为其中提供了有关 Microchip 产品性能和

使用情况的有用信息。Microchip Technology Inc.及其分公司和相关公司、各级主管与员工及事务代理机构对译文中可

能存在的任何差错不承担任何责任。建议参考 Microchip Technology Inc.的英文原版文档。
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本出版物中提供的信息仅仅是为方便您使用 Microchip 产品或使用这些产品来进行设计。本出版物中所述的器件应用信

息及其他类似内容仅为您提供便利，它们可能由更新之信息所替代。确保应用符合技术规范，是您自身应负的责任。

Microchip“按原样”提供这些信息。Microchip 对这些信息不作任何明示或暗示、书面或口头、法定或其他形式的声明
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允许的最大范围内，对于因这些信息或使用这些信息而产生的所有索赔，Microchip 在任何情况下所承担的全部责任均

不超出您为获得这些信息向 Microchip 直接支付的金额（如有）。如果将 Microchip 器件用于生命维持和/或生命安全应

用，一切风险由买方自负。买方同意在由此引发任何一切损害、索赔、诉讼或费用时，会维护和保障 Microchip 免于承

担法律责任。除非另外声明，在 Microchip 知识产权保护下，不得暗中或以其他方式转让任何许可证。
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